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About Club Web

General

Selling on the Internet is profitable, viable and growing rapidly.  Information, products, and services can all be made available through an organization’s Web site. Businesses continually analyze ways to add revenue, cut costs, and increase return on investment and market penetration, electronic commerce has the potential to accomplish these goals.  Typically, e-commerce applications have been cost prohibitive to most businesses.  Compaq, Microsoft, INEX, and MPACT are changing the rules of on-line commerce with low-cost, feature-rich solutions that make Web stores accessible at an affordable price.

These new technologies require business leaders to establish new partnerships and seek new expertise to ensure successful implementations.  In the past, enterprise solutions involved key partners such as resellers, VARs, consultants and systems integrators.  However for Internet solutions there are new players that are required, in addition to these.  Partners such as Internet Service Providers (ISPs), Commerce Service Providers (CSPs), and Web Developers play a crucial role in recommending and delivering complete Internet solutions.

Compaq’s new Internet solutions delivery strategy involves giving the customer exactly what they want, in a configuration that has been tested and recommended by Compaq engineers, through a channel that networks resellers, ISPs, Web Developers and support organizations to deliver a complete solution.

This new delivery model is referred to as “Smart Solutions/Smart Methods”!  The new community of Internet solution partners (part of the Compaq Solution Partners program) is called Club Web!  The Club Web Internet site will host this community and provide education, training, leads, partnering opportunities and much, much more to both end users and channel partners.

Club Web is the one-stop-Web site for today’s Internet-based business solutions.  End users may visit to learn how these solutions address issues important to them today:

· Employee productivity

· Customer access & satisfaction

· Internet Commerce security

Channel partners may also learn the latest in technology from on-line training conducted by industry experts.  Discussion groups will also enable partners to share ideas and solutions to problems with other partners located throughout the country.  Compaq will also help you find the right partners to deliver a solution to your customer.

Benefits:

· Compaq Solution Partner designation

· Leads

· ASE training discounts

· Access to Compaq’s ISP Help Desk (fee based service)

· Access to Compaq’s ISP Lease Program (pending financial approval)

· “Hosting Powered by Compaq” and member logo for hanging on Web site

· “Hosting Powered by Compaq” banner for hanging in hosting/operation center

· On-line training

· Learn about the latest trends, solutions and cutting-edge applications

· On-line discussions with industry experts

· On-line discussions with other partners

· Partnering locator

· Find ISPs, Web Developers and VARs to help you deliver your solution

Requirements

· Standardized on Compaq servers for hosting or operations and/or Microcom access devices for access services.  At least one Compaq server or Microcom access device must be installed within 60 days

· At least one technician that has completed “Servicing Compaq Servers” if any are installed
· Those companies offering dial up services must have a user to modem ratio of 12-1 or less

· Club Web Configuration

· See Appendix: Becoming a BuyWay Merchant. 

Club Web Solution Overview

Electronic Commerce Environment

· Merchant with INEX Storefront Catalog running on Compaq NT with Site Server Commerce Edition or Microsoft Commercial Internet System (MCIS).

· A firewall to protect Catalog and data.

· MPACT Immedia’s BuyWay transaction processing service for payment.

· Shopper with Microsoft Wallet (optional).

Compaq ProLiant E-Commerce Server 

Compaq is providing its Authorized Resellers with pre-validated server configurations including part numbers for the Compaq ProLiant E-Commerce Server.  Compaq is marketing its ProLiant E-Commerce Server to customers as a fully integrated E-Commerce web presence solution.  Compaq is recommending that customers contact their Compaq Authorized Reseller to determine the configurations most appropriate for their environment.  Recommended configurations are being provided only to Compaq Authorized Resellers to enable you to more confidently help your customer’s plan and deploy their E-Commerce web presence. 

Description

The Compaq ProLiant E-Commerce Server enables merchants, web developers and ISPs to create a pre-validated e-commerce web presence solution.

The Compaq ProLiant E-Commerce Server bill of materials lists the hardware and software components used to easily create a pre-tested, reliable web server for merchant sites. Compaq ProLiant E-Commerce Server utilizes Microsoft’s Commerce Server (available as a component of Site Server and Microsoft Commercial Internet System.) as the basis for building a virtual store front.

Two server platforms are offered to meet the needs of merchants ranging from entry level to advanced high sites.  These servers include the ProLiant 850R for entry-level sites and the ProLiant 6500 for sites required additional capacities.

The ProLiant 850R is ideal as an entry-level configuration for merchants and ISPs. 

The ProLiant 6500 provides a high capacity single server platform. 

Standard configurations

· Compaq ProLiant Server Platform

· Microsoft® Windows NT® Server 4.0

· Microsoft Internet Information Server (IIS 4.0)

· Microsoft Commerce Server (included in Microsoft Site Server, Enterprise Edition 2.0, Microsoft Site Server, Commerce Edition, Version 3.0, or Microsoft Commercial Internet System).

· Microsoft MS SQL Server

· Compaq Insight Management (CIM)

ProLiant E-Commerce Server offers pre-tested configurations, simplifying planning and deployment of an E-Commerce Web Site. 

A customer’s time to establish their storefront is reduced when starting with a pre-validated configuration. Two platforms address a range of needs for an entry-level site up to an e-commerce application requiring additional capacities. Using industry standard technology assures investment protection as e-commerce sites grow in traffic and complexity. 

Built-in Management

All Compaq servers feature Compaq Insight Manager, a comprehensive management tool that facilitates greater application availability by monitoring the operation of Compaq servers and proactively notifying administrators of impending hardware failures. Compaq Insight Manager gives administrators real control through its intuitive visual interface, comprehensive fault and configuration management, and industry-leading remote management. 

Microsoft Commerce Server 

Microsoft Commerce Server is a comprehensive web site environment for developing, deploying and managing an e-commerce site. (Microsoft’s Commerce Server is available in Microsoft Site Server, Enterprise Edition, Version 2.0, Microsoft Site Server, Commerce Edition, Version 3.0, and Microsoft Commercial Internet System.) Microsoft Commerce Server includes tools for content creation, database creation, usage analysis, and application development including the ability to extend the site with third party components. 

INEX

 Storefront Catalog creation software. See details in INEX documents.

MPACT Immedia’s BuyWay

Internet Transaction Processing for credit card payment, notification and reporting. Discussed in detail in this document.

Maintenance & Support

Compaq

CompaqCare provides a wide range of service offerings including:

· 3 year limited warranty fully supported by a worldwide network of resellers and service providers

· lifetime toll-free 7 x 24 hardware technical phone support

· Pre-Failure Warranty coverage of hard drives, memory and Pentium Pro processors 

· Software installation and support is not provided by Compaq

· Compaq Authorized Resellers should contact the software manufacturer for additional support. Certain restrictions and exclusions apply. Consult the Compaq Customer Support Center for details.

Microsoft

Site Server 3.0, Commerce Server RTM & Support

MSFT will offer customers ability to purchase premier support contracts, 10 pack support incidents or 1 support calls at $195. 

See Site Server Commerce Edition documentation for more details

INEX

On-line knowledge base and product FAQ information at www.inex.com.  Support fee per incidence for setup, installation, and “How To” for product suite.  Compaq customers will receive one (1) free call per customer

MPACT Immedia’s BuyWay

Hours of operation

It is the intent for BuyWay to be a 24-hour a day 7 days per week service. Scheduled down time, if necessary, will occur between the hours of 1:00 am and 8:00 am (EST) Mondays. 

Help Desk Hours

There are two different types of support:

· The General help desk is currently manned during regular 9am to 5pm EST working hours. The help desk can be reached by dialing (514) 397-9747 extension 249. A voice mail is in place when an agent is unavailable. Support to 5pm on the West Coast will be added in the near future.

· The System Support Help Desk will be available workdays from 8am to 8pm (EST) via MPACT Immedia's 1-800-361-7252 number. The purpose of this line is to be able to address BuyWay system problems that cause merchant to operate incorrectly in any way. 

· Emergency System support will be available 24 hours per day through the "911" IVR system accessible through MPACT Immedia's 1-800-361-7252 number.

Pricing & Purchasing

Compaq

Compaq ProLiant Servers are available through all Compaq Authorized Resellers.  To locate your nearest reseller call 800-345-1518 or use our Online Reseller Locator at http://www.compaq.com/.  For information on Compaq Internet Solutions visit http://clubweb.compaq.com/.

Microsoft

See Microsoft representative or agent

INEX

Go to www.compaq.com/smb/onlineservices

MPACT

BuyWay’s Pricing for Merchants is comprised of three basic components:

1) A nominal one-time set-up fee includes the following:

· Registration of the merchant with the card processor

· Configuration of the security file from a certified third party for transmission of merchant data to the processor

· Setting up BuyWay to accept the merchant site.

2) A monthly minimum administration fee (includes the first 100 transaction fees for the month):

· storing transactional and statistical information in our database

· making this information available securely to the merchant on our server

· sending transaction information via computer file at regular intervals

· maintaining merchant files on our system

3) Transaction fees (after the first 100)

BuyWay has many options and many opportunities for customized approaches. Since pricing varies according to BuyWay features selected, level of customization etc., merchants should contact a BuyWay representative or authorized agent for a personalized quotation. 

Please contact an MPACT Immedia BuyWay representative for current pricing information.

Conclusion

The Internet evens the playing field. A low cost solution based on Club Web is available so that even the smallest ventures can participate. No one player dominates or controls the Internet. Internet marketing can stand-alone or be combined with traditional sales & marketing efforts.

From Fortune 500 multinationals to one-man operations, businesses of all sizes have based their strategic directions on Internet solutions. And for good reason, the Internet offers an opportunity for market diversification. The Internet can serve as a new market for existing products, a way to extend the reach of current sales efforts; a new target market! 

Welcome to Club Web…  Partnering to provide… Zero to Store-front in 24 hours!

Installation

General Platform Setup

The “Quick Setup” section gives a high-level overview of all the major tasks necessary to install Commerce Server and Ad Server. Detailed descriptions of each of the following tasks are provided in the following sections.

Quick Setup of the Platform Software

1. Install Microsoft® Windows NT® Server 4.0 and Service Pack 3. Format the hard drive with the Microsoft® Windows NT® File System (NTFS). Add your account to the local Administrators group.

2. Install SQL Server version 6.5 (or another ODBC-compliant database management system). Install SQL Server Service Pack 3. If you are installing SQL Server on a remote computer, it is recommended that you use Transmission Control Protocol/Internet Protocol (TCP/IP) sockets.

3. Set Up the Databases for sample data.

· Register the SQL Server and set the number of user connections.

· Create the Databases by creating a database device, a database, and a log for the Commerce Server sample site data, and another device, database, and log for the Ad Server sample data.

· Reconfigure the tempdb database.

· If you are running your database on a remote computer, set Windows NT account permissions on the remote computer (see Enable Access to Remote SQL Server Databases). Make sure that the MSDTC service is running on both the local and the remote computer.

4. Create ODBC data source names (DSNs) for the Commerce Server and Ad Server databases (see Create DSNs for the Databases).

5. Install Windows NT 4.0 Option Pack, including Microsoft® Internet Explorer version 4.01. 

6. Install Microsoft® Site Server Standard Edition.

7. Test your installation.

Software Requirements

The suggested software configuration for a single dedicated Commerce Server 3.0 installation is as follows:

· Windows NT Server version 4.0 with Windows NT Service Pack 3 or later . (SP3 can be downloaded for free from http://www.microsoft.com/ntserver/.) Note that installation on a Backup Domain Controller (BDC) is not supported.

· TCP/IP, which can be installed with Windows NT Server 4.0. Use the Network utility in the Windows Control Panel to install and configure the TCP/IP protocol and related components.

· Microsoft® Internet Information Server (IIS) version 4.0. This is part of the Windows NT 4.0 Option Pack, available for download from http://www.microsoft.com/iis.

· Internet Explorer 4.0x, which is included with the Windows NT 4.0 Option Pack, and can also be downloaded from http://www.microsoft.com/ie/.

· SQL Server 6.5 is the recommended database. If you use SQL Server, you must also install the SQL Server Service Pack 4, which is available from http://www.microsoft.com/SQL. Note that SQL Server version 6.5 must already be installed before you can install Service Pack 4. If you are installing SQL Server on a remote computer, it is recommended that you use TCP/IP sockets.

File System Requirements

Microsoft NT File System (NTFS) formatted hard drive required

Install Windows NT Server 4.0 and Service Pack 3

· Install Windows NT Server 4.0, following the prompts of the Setup program. When the setup program prompts you for the file system to use, specify NTFS.

· Install the Windows NT 4.0 Service Pack 3, available for free download from http://www.microsoft.com/ntserver/.

· Setup NT Server as a standalone server with  the user name “administrator” configured with a blank password. 

· Select TCP/IP as the network transport.

Install Windows NT 4.0 Option Pack

Site Server requires Internet Information Server (IIS) 4.0, which is installed as part of the Windows NT 4.0 Option Pack. Commerce Server 3.0 also requires Microsoft Transaction Server (MTS) to support transacted database operations. MTS is also installed as part of the Microsoft Windows NT 4.0 Option Pack. 

To install the Microsoft Windows NT 4.0 Option Pack

1. Run the Setup.exe program.

2. When the Welcome screen appears, click Next to continue.

3. On the End User License Agreement screen, read the license agreement and then click Accept to indicate that you agree to the terms of the agreement. (If you do not agree, click Decline and Setup will exit.) 

4. On the next screen, click Typical. 

5. Accept the default locations for the directories or type the paths you want, making sure that the drives you select are formatted as NTFS, and then click Next.

6. Accept the default location for the SMTP mail directory or type the path you want, making sure that the drive you select is formatted as NTFS, and then click Next.

7. The setup proceeds.

8. When all files have been installed, the Finish screen is displayed. Click Finish. 

9. You must restart your computer to complete the installation.

10. In the System Settings Change dialog box, click Yes to confirm that you want to restart the computer.

When the computer restarts, Setup finishes the configuration.

Install SQL Server 6.5

SQL Server 6.5 or later is the recommended database management system for use with Commerce Server and Ad Server. Running Setup on a SQL Server database is the most automatic method of installing the sample data.

Note   SQL Server (or any other database management system you use) can reside on a computer other than the one on which Commerce Server or Ad Server is installed.

To install SQL Server

Note   The following installation procedure assumes that you are installing SQL Server to use on a non-production system. Use no password on the sa account  to facilitate easy access while you familiarize yourself with the system, but is not recommended for a live, production system.

1. Run the SQL Server Setup.exe program.

2. When the Welcome screen appears, click Continue to proceed.

3. Type your Name, Organization, and the Product ID number (from the back of your compact disc case), and then click Continue. Click Continue to confirm the information you typed; otherwise, click Change to make changes.

4. When Setup prompts you to choose an installation option, select Install SQL Server and Utilities, and then click Continue.

5. In the Choose Licensing Mode dialog box, click Per Server, and then click Add Licenses. In the New Client Access License dialog box, click the Quantity box, type the number of server licenses you have purchased, and then click OK (choose 100 here).

6. Read the license agreement, select the check box, and then click OK. In the Choose Licensing Mode dialog box, click Continue. In the Per Server Licensing dialog box, read the Client Licensing agreement, select the check box, and then click OK to proceed with setup.

7. In the SQL Server Installation Path dialog box, accept the default drive and directory or specify a new one, and then click Continue.

8. In the Master Device Creation dialog box, accept the default drive and directory on which the master device will be created or specify a new one, and then click Continue.

9. In the SQL Server Books Online dialog box, select Install on hard disk, and then click Continue.

10. In the Installation Options dialog box, select the Auto Start SQL Server at boot time check box. Click Networks, select the TCP/IP Sockets check box, and then click OK. Click Continue.

11. In the SQL Executive Log On Account dialog box, select Install the SQL Executive service to log on to Windows NT as administrator. The login name you type must be a member of the Windows NT Administrators group on the local computer (see Add Your Account to the Local Administrators Group). Type the administrator name and password, retype the password to confirm it, and then click Continue
12. In the TCP/IP Socket Number dialog box, either accept the default port number or type a new one, and then click Continue. 

SQL Server is installed on your computer.

To install Microsoft SQL Server Service Pack 4

The following procedure assumes you are installing SQL Server Service Pack 4 from the Site Server 3.0 compact disc. 

1. Exit SQL Enterprise Manager if it is running. 

2. Use Windows NT Explorer to navigate to the \Support\QFE\Sql65sp4 folder, and then run the setup program. Follow the online instructions. 

3. When the SA Password dialog box appears, leave both password boxes blank, and then click Continue. 

Note   In a production environment, you must protect the system administrator (SA) account with a password, but for this installation, leave it blank for easy access

After you have installed SQL Server and SQL Server Service Pack 4, you must install the SQL Server updated executable file SQLSERVR.EXE. 

To install the updated executable file SQLSERVR.EXE

After installing SQL Server Service Pack 4, you must install the updated executable file SQLSERVR.EXE, which is provided on the Site Server 3.0 compact disc. This updated executable is required to ensure compatibility between Site Server and SQL Server version 6.5. If you do not have access to your Site Server 3.0 compact disc, this updated executable, SQL Server build 291, can also be obtained by contacting Microsoft Product Support.

The following procedure assumes that MSSQLServer is stopped. To verify that MSSQLServer is stopped, on the Start menu, point to Programs, point to Microsoft SQL Server 6.5, and then click SQL Service Manager. The stop light should be red. If it isn’t, double-click Stop to stop your server now. 

1. Insert the Site Server 3.0 compact disc into the appropriate drive of your SQL Server computer. 

2. Use Windows NT Explorer to navigate to the \Support\QFE\Sql297 folder on the Site Server 3.0 compact disc. 

3. Select SQLSERVR.EXE and copy it to the \Mssql\Binn folder on the computer that is running SQL Server. It should overwrite the existing SQLSERVR.EXE file on your computer. 

4. Close Windows NT Explorer. 

Set Up the Databases

The following installation procedure assumes that you are using SQL Server and that you are setting up a non-production system. The recommendation to use the system administrator (sa) account with no password is to facilitate easy access while you familiarize yourself with the system. The recommendation to set the Truncate log on checkpoint option may conflict with policy of your database administrator, so be sure you verify settings before going live with a site.

1. Set up the Site Server databases. 

· If your SQL Server resides on a remote computer, the MSDTC service (Microsoft® Distributed Transaction Coordinator) must also be installed and started on both the local (IIS) computer and the remote (SQL Server) computer. 

· Register the SQL Server and set the number of user connections. 

· Create three database devices. The following table provides recommended settings. 

Device
Size
Description

SiteServerDATA
130 MB
For holding the databases.

SiteServerLOGS
40 MB
For holding the logs.

CommerceDATA
60 MB
For holding store databases

CommerceLOGS
15 MB
For holding store logs

SiteServerTEMPDB
25 MB
For increasing the size of the tempdb database.

· Create three databases for your, using the data and log devices you just created. The following table provides recommended settings.

Database 
Data Device Size
Log Device Size

Membership
40 MB (use SiteServerDATA)
10 MB (use SiteServerLOGS)

Analysis
50 MB (use SiteServerDATA)
10 MB (use SiteServerLOGS)

Commerce
50 MB (use CommerceDATA)
10 MB (use CommerceLOGS)

· Increase the size of the tempdb database to 25 MB, using the database device (SiteServerTEMPDB ) you just created. Select the Truncate Log on Checkpoint option. 

To create a database device

1. Run SQL Enterprise Manager, from the Start menu, point to Programs, point to Microsoft SQL Server 6.5, and then click SQL Enterprise Manager.

2. Make sure that SQL Server is running (the icon in the Server Manager window displays a green light). If it is not running, right-click the name of the SQL Server computer, and then on the shortcut menu, click Start (you might need to log into SQL using the sa account with the blank password)

3. Click the plus sign (+) beside the name of the SQL Server computer.

4. Right-click Database Devices, and then on the shortcut menu, click New Device.

5. In the New Database Device dialog box, type a name and size for the device from the table above. Leave the other options at their default settings, and then click Create Now.

6. Repeat Steps 4 and 5 to create each new database device.

To create a new database

1. Right-click Databases, and then on the shortcut menu, click New Database.  The New Database dialog box is displayed.

2. Type a name from the table above in the Name box. Select the Data Device and Log Device from the drop-down list box, and set the size in the Size box. See the table above for recommended values.

3. Right-click the database you just created, and on the shortcut menu, click Edit. Click the Options tab and select the Truncate Log on Checkpoint check box. Click OK.

4. Repeat Steps 1 through 3 to create all of the databases listed in the table above.

Reconfigure the tempdb Database

The SQL Server tempdb database should be at least 4 MB in size, and should have the Truncate Log On Checkpoint option selected. The default size of tempdb in a new SQL Server installation is 2 MB. The following procedure describes creating a new device for expanding tempdb, but you can also use an existing device with at least 2 MB of available space.

To reconfigure the tempdb database

1. Click the plus sign (+) next to Databases to expand the folder, and then right-click tempdb. On the shortcut menu, click Edit.

2. In the Edit Database dialog box, click Expand.

3. For Data Device, click the name of the device you created earlier (SiteServerTEMPDB).  For Size (listed in MB), type 23 (to expand the total size to 25 MB), and then click Expand Now.

4. Click the Options tab and select the Truncate Log on Checkpoint check box. Click OK. 

Truncating the log is recommended to avoid overflow problems while loading sample data during Setup. Consult your database administrator if your organization has a policy against truncating the logs.

5. Close SQL Enterprise Manager.

Create a database account for managing a Commerce database.

This step creates a SQL user account that will be used by both the DSN connection string to connect to the database and to provide access to a Commerce Admin to manage a Commerce Database. This is the preferred method to grant access and manage a Commerce Database rather than using the SA account, which gives too broad a set of privileges.

To create a database account for managing a Commerce database.

1. In Enterprise manger select Manage/Logins.

2. Create a login name (CommerceAdmin) and give the login a password .

3. Click in the Permit box for the Commerce database. 

4. Click Modify and then Close.

5. Right Click on the Commerce and select Edit
6. In the edit database dialog, select the Permissions tab.

7. For the CommerceAdmin login that was just created, click on each of the permission boxes to grant full admin privileges to CommerceAdmin for the Commerce database.

Create System Data Source Names

This procedure assumes you have not yet installed the Windows NT 4.0 Option Pack. If you have installed it, you will be prompted for additional information. 

You will need to create three system Data Source Names (DSNs). See the following table:

DSN
Database

Analysis
Analysis

Membership
Membership

Commerce
Commerce

To create a system DSN

1. On the Start menu, point to Settings, click Control Panel, and then double-click the ODBC icon. 

2. The ODBC Data Source Administrator dialog box appears. 

3. Click the System DSN tab, and then click Add. 

4. The Create New Data Source dialog box appears. 

5. Select the database driver for which you want to set up a DSN. The following procedure is for configuring a DSN for a SQL Server database, and therefore assumes that you select SQL Server. Click Finish to proceed. 

6. The ODBC SQL Server Setup dialog box appears. 

7. In the Data Source Name box, type the name that you will use to identify this DSN. See the table above for recommended names. 

8. In the Server box, enter the name of the SQL Server on which your database is located, and then click Next. 

9. Select the With SQL Server authentication using a login ID and password entered by the user option. Change the Login ID box to CommerceAdmin. Click Next.

10. Click Change the default database to: and then select the name of the database from the drop-down list box. See the table above for the database to associate with each DSN. Click Next.

11. Click Next.

12. Click Finish. 

13. Repeat steps 3 through 12 for each DSN.

14. Click OK to close the ODBC Data Source Administrator dialog box.

Install Site Server Standard Edition

You must install the Standard Edition of Site Server before you can install the Commerce Edition. The following table lists the dependencies that the Commerce Edition has on the Standard Edition.

Commerce Edition component
Dependency on
Comment

Ad Server
Site Server Analysis
Necessary if you want to generate performance reports from the Ad Server data logged in the IIS log.

Commerce Server
Site Server Knowledge
Necessary if you want to install and use the Trey Research sample site, which demonstrates subscriptions and membership

On the Site Server Standard Edition compact disc, run the Setup.exe program, located in either the \x86 or \Alpha directory, depending on your platform. Setup instructions are located on the compact disc.

To perform a complete installation of site server

1. Insert the Site Server 3.0 compact disc into the appropriate drive (or load off of the net). 

The Site Server 3.0 Setup program starts. 

2. Click the Server Installation link, and then follow the online prompts. 

3. In the Specify Product and User Information dialog box, type your name, company, CD-Key (from the back of your compact disc case), and e-mail address, and then click Next. In the Product ID Confirmation dialog box, click OK to confirm the product ID you typed. 

Your e-mail address is required by Search. If you do not enter it here, you will be prompted again later in the Setup process. 

4. In the Specify Microsoft Site Server 3.0 Folders dialog box, Setup displays the locations where the Site Server folder, the Data folder, and the Sites folder are to be installed. If desired, click Browse to change the folders. Click Next to continue. 

When you install Site Server in a production environment, it is strongly recommended that you use NTFS. 

5. In the Choose Installation Type dialog box (choose Typical), click the Complete icon. 

The Specify a Program Folder dialog box appears. 

6. Verify the folder into which the Site Server program items will be installed. By default, Setup creates a Microsoft Site Server folder, but you can select a different folder from the Existing folders list if you want. Click Next to continue. 

The Configure User Accounts dialog box appears. 

7. Select Publishing, and then click Set User Account. Type the name of your Windows NT user account, password, and domain, and then click OK (use administrator and the local machine for the domain). Repeat for Search. When finished, click Next to continue. 

To assign the same account to Publishing and Search, press shift, select both features, and then click Set User Account. 

For the Search feature, the Windows NT user account that you type must have administrator privileges for this computer. 

8. In the Stop Services dialog box, Setup lists the services it is going to stop. Click Next to continue. 

Setup stops the services, and then lists the Site Server features it is going to install. 

9. Click Confirm to continue. 

Setup starts installing Site Server on your computer. The installation process takes several minutes. 

If files were in use during setup, you may be prompted to restart your computer. After your computer restarts, press ctrl + alt + delete to log on, using the same login account as before. Setup automatically continues installing Site Server. 

During the installation process, Setup restarts your services. When Setup is complete, a dialog box notifies you that Site Server was successfully installed. 

10. To view the Site Server Readme, select Open Readme file, and then click Finish. 

The Site Server 3.0 Readme file is opened. It provides late-breaking information about Site Server 3.0. 

Set up Commerce Server 3.0

The following installation procedure assumes that you are using SQL Server and that you are setting up a non-production system. The recommendation to use the system administrator (SA) account with no password is to facilitate easy access while you familiarize yourself with the system. 

Install Site Server Commerce Edition

The Setup program detects the presence of Windows NT Server 4.0 and IIS 4.0. If these components are not present, Setup will prompt you to exit and install missing software. 

Before you run Setup, check the following:

· Make sure your login account is a member of the Windows NT Administrators group on the computer where you are installing Site Server.

· Make sure that you have already set up the databases and system DSNs for the sample sites that you want to install (see Set Up the Databases and Create DSNs for the Databases). 

· Make sure that the MSSQLServer service is running. 

· If you are unsure that the service is running the way to check this is as follows:

· On the Start menu, point to Settings, and then click Control Panel. Double-click the Services icon, scroll down to the MSSQLServer service, and verify that its status is Started. If not, select MSSQLServer and then click Start. 

To install Commerce Server

1. On the Commerce Server compact disc, run the Setup.exe program, located in either the \x86 or \Alpha directory, depending on your platform. For the LAB a pointer will be given with the commerce setup on it.

2. When the Site Server Commerce setup screen appears, click server installation and then click Next to proceed.

3. Yes to indicate that you agree to the terms of the license agreement. If you do not agree, click No and Setup will terminate.

4. On the User Information screen, type your Name, Company, and Serial number (from the back of your compact disc case), and then click Next to continue. For the lab fill in the Serial Number text box with all “1’s”.

5. On the Installation Choice screen, click the button for the type of installation you want. FOR THIS INSTALLATION CHOOSE CUSTOM AND SELECT THE CLOCKTOWER AND VOLCANO COFFEE STARTER SITES ONLY. DESELECT THE OTHER STARTER SITES AND OPTIONS. Click Next
Note: that Custom displays a list of all available components; you can select the components you want to install. By default, the components that are initially selected are the same components installed by the Typical option.

6. On the Components screen, select the list of components that will be installed and then click Next.

7. On the Database Configuration screen, specify the system DSN and database login name for the sample data (Commerce), and then click Next. Setup uses the DSNs and database login IDs to connect to the databases when it runs the SQL scripts that create the schema and load the sample data.

· To specify a DSN, select the sample sites, and then click Set DSN. In the Select System DSN screen, click the DSN you want to use for the selected sample sites, and then click OK. 

Select the CommerceAdmin database user account created earlier, enter a valid password and click Next.

8. Setup proceeds

9. Click Finish, and then exit setup

Test Your Installation

1. Launch IE. Load URL

http://localhost/siteserver/admin/commerce/default.asp
Click Server Administration in the left browser pane.

2. Highlight the ClockTower site in the Commerce Site Name list and click Shop. The ClockTower commerce site is launched.

To make purchases in the Commerce Server sample sites you can use the following test credit-card numbers: 

· American Express: 3111-111-111-1117

· Visa: 4111-111-111-1111

· MasterCard: 5111-111-111-1118

· Discover: 6111-111-111-1114

3. Experiment with creating a new commerce site. 

Create the Site Foundation

· Click the create button on the http://localhost/siteserver/admin/commerce/default.asp page

· Choose the default web site and click next

· Enter a short name (ex. “teststore” and a Display name (ex. “Bob’s Fantastic Commerce Site”) for the site you are creating. Click next,

· Accept the directory defaults and click next.

· Highlight a DSN, and enter a valid database login and password and click next.

· Select use and existing NT user account and click next.

· Choose the domain (or local machine name) and click next.

· Select the Windows NT user account that will be designated the manager for this site. For this lab use the administrator account.

· Click Finish.

· A page with a hyperlink to a URL appears that will take you to the Commerce Site Builder Wizard. Click on the URL to fire up the Commerce Site Builder Wizard.

Create the Site

· Click on Start Commerce Site Builder Wizard 

· Click on Create Copy of a Site and Choose ClockTower. Click Next.

· Click the Finish button to create the site.

· Click the “Here is your shopping site “ to go to the site or Click the “Here is your Manager site” to go to the manager site.

Commerce Server 3.0 Performance Testing

Microsoft Commerce Server Performance testing is a very complex and detailed topic. The intent of this section is to explore some of the performance testing tools and techniques that can be used to model performance for a Microsoft Commerce Server 3.0 site. It is suggested that the tools and techniques here be used to build test models that are representative for your particular situation. 

These techniques are also relevant for measuring throughput for an Active Server Pages Site. 

1. On the Start menu click Run. Enter perfmon.exe and click OK.

2. In perfmon from the Edit menu click Add to Chart and add the following objects and counters to the chart. Use your machine for the computer name. Click the Add button after each choice is made. When you are finished adding the objects and counters, click Cancel and perfmon will be left in a state displaying a performance chart.

Note   please choose a different color for each counter to make the chart easier to read.

Object
Counter
Scale

Processor
%Processor Time
Default

ASP
Requests Rejected
Default

ASP
Requests per Sec
1.0

ASP
Requests timed Out
1.0

ASP
Requests Queued
1.0

ASP
Memory Allocated
0.00000100

Memory
Pages Per Sec
1.0

3. Leave perfmon running with the selected counters. From the Start menu point to Programs, point to Internet Benchmarking, and then click Inetload.  

4. In Inetload from the File menu click Open and select browse.inl 

5. Use notepad.exe (or any text editor) to look at the browse.txt and the text files that browse.txt calls to familiarize your self with an Inetload script file.

6. In Inetload, select the target server to be your machine name. Select the number of users to be 5 and the number of threads to be two. Select the HTTP 1.1 button.  Select the test duration to be 2 minutes. Click the Run Test button

7. As the Inetload threads fire up, look at test status counters in InetLoad. Go back to perfmon and monitor the performance chart. 

Are the performance numbers generated what was expected? Any surprises?

When the InetLoad simulation finishes look at the Inetload log generated in the in the Inetload directory. Is this what was expected?

8. Repeat step 4-7, this time bump up the users and threads to put a larger load on the server (try 30 users and 15 threads for 2 minutes). Monitor perfmon and the test status counters in InetLoad 

9. Repeat Steps 4-7 this time running the purchase.inl file

Installing and running INEX Commerce Court Server Extensions

1) Installing INEX Commerce Court Server Extensions.
To run INEX Commerce Court Server Extensions you must have Microsoft Option Pack installed on the computer.

a) Install Microsoft Active Directory Service namespace providers. It can be downloaded from Microsoft’s web site or run directly from INEX CD.

b) Install INEX Commerce Court Server Extensions. Run Setup program and follow the online instructions.

2) Running INEX Commerce Court Server Extensions for the first time.

a) When you run INEX Commerce Court Server Extensions it checks if IIS server has INEXSupport virtual directory. This virtual directory contains some files that must be accessible by merchants. The server extensions will warn you that it is going to create INEXSupport virtual directory. Press OK to continue.

b) When administrative parameters are not specified the server extensions will ask you to provide it and present Preferences dialog window. In Preferences dialog do the following:

i) Specify ODBC DSN. Press Select... button to select ODBC data source. In the ODBC dialog select LocalServer in the Machine Data Source tab. Press OK. Provide user name and password to connect to database server. You must specify administrators user name (usually  SA) and password.

ii) Specify root directory for stores. Press Browse button to select existing directory or create new one on NTFS partition. Do not create root directory for stores in InetPub/WWWRoot directory.

iii) To create users in local security database check Create local users checkbox.

iv) Click OK button.

3) Creating a store using INEX Commerce court Server Extensions.

a) Run INEX Commerce Court Server Extensions. (Click Start/Programs/ INEX/ INEX Commerce Court Server Extensions).

b) Click Create New Store button on menu bar.

c) If the program asks you to provide administrative login parameters specify username and password for database access (Usually SA).

d) The program will show first screen of the new store wizard. If you want to disable this introductory screen in the future check Don’t show me this again. Click NEXT.

e) Provide store name, login name and password for the new store and click NEXT.

f) In dropdown boxes select database device for database and for database log. Specify 5 MB for database and 2 MB for database log. Check Truncate log on checkpoint checkbox. Click NEXT.

g) In most cases you do not have to change path to root directory so just press NEXT.

h) Select Default Web Server in dropdown box and press NEXT button.

i) Check summary information and if everything is OK press Finish. The summary gives you parameters for configuring the INEX Commerce Court client program.

Note   These instructions are for configuration where the computer is standalone server connected to a Windows NT domain. MS SQL server is installed on the same computer 

For further information please read manual.

Creating a store using INEX Commerce Court Professional

To create a store using INEX Commerce Court Pro

1. From the Start menu, choose Programs, and then click INEX Commerce Court Pro.

2. Click Continue.   The Welcome screen appears.

3. To open the sample CompuSell store, click Open Sample Store.

4. Click Company/Address Description to go to the Your Company Information screen.

5. On the Name/Address tab, enter your company’s name, address, phone number, and fax number.

6. Click the Description tab.  Enter a description of your company’s products and services. This description will appear on the front page of your Web store.

Note   You can use HTML tags, such as <B> and <I> in your description
7. Click the Logo tab.


8. Click the Email Address tab. In the “Email Name” boxes, enter the email addresses customers can use to contact you. 

9. Click Next to go to the Protecting your data screen.

10. Click Next to go to the Starting Numbers, Next Entries screen.

11. Click Next to go to the Payment Terms screen.

12. Click Next to go to the Default Tax screen.

13. Click Next to go to the Default Tax Charges screen appears. 

14. Click Next to go to the Default Shipping Methods screen.

15. Click Next to go to the the Setup Complete screen.

16. Click Finish
To enter your ISP information
1. If the Main Menu is not already open, for the Options menu, choose Main Menu.

2. Click the Publishing to the web tab.


3. Click Hosting Web Server/ISP.


4. In the WWW Server Name box, enter the IP address or domain name of the server computer that is hosting your Web store.

5. In the Account ID box, enter your login ID for your Web store account on the server.

6. In the Password box, enter your password for your Web store account on the server.

7. In the WWW Store Directory from main Web URL box, enter the name of your store directory on the server.

8. In the ISP Server Name box, enter the name of the server computer that is running Commerce Court Server Extensions. This may be the same as the WWW server name.

9. Click Finish.

To set up the Payment Gateway

1. If the Main Menu is not open, from the Options menu, choose Main Menu.
2. Click the Setup company tab.

3. Click Payment Terms. The Payment Terms screen appears.


4. Click the Install/configure gateway button. The Payment Verification System Configuration Wizard screen appears. 


5. Click Next.

The payment gateways shipped with Commerce Court Pro, and any additional gateways you have installed, are listed.

When you select a payment gateway in the list, a link to more information about the gateway appears.

6. To view more information about a payment gateway:

Select a payment gateway from the list.

Click the link that appears beside For more info, visit. Commerce Court Pro launches your Web browser. You must be online to access this information.

7. Click Finish to exit the wizard. You return to the Payment Terms screen.

8. To select a payment gateway:

· Select Use Registered Third-Party System.

· Select a payment gateway from the list.

9. Click Next.

10. Depending on the payment gateway you selected, you may be required to register with the payment gateway vendor. Follow the instructions that appear on the screen.

To publish your Web store 

1 If the Main Menu is not already open, from the Options menu, choose Main Menu.

2 Click the Publishing to the web tab.


3 Click Publish to Web Server. The Web Publishing Wizard screen appears.

4 Select Create Remote Web store.

5 Click Continue.

Commerce Court Pro sends all your information to the server computer. The Publishing dialog box appears.

6 Click OK.

To veiw your online Web store

1. If the Main Menu is not already open, for the Options menu, choose Main Menu.

2. Click the Publishing to the web tab. 


3. Click Publish to Web Server. The Web Publishing Wizard screen appears.

4. Click Preview Store on Remote ISP.

5. Click Continue.

To purchase a product
Shop on the site and select products.

When you are ready to pay click on the shopping basket and click to pay.

Use the text entry form since you are not setup for Microsoft Wallet and enter your personal information.  Every field must be filled in and you msut have proper state and contry values (this is for calculating the purchase tax).

On the orderform page you must enter an e-mail address and provide a name on credit card. Use Master Card for a credit card with a credit card number of  5010000010001003 and an expiration date 12/99.

Click the order now button and wait for the results of the transaction. Note that this payment process uses the MPACT payment component and is validated over the Internet is a simulated real time transaction.

Retrieving Sales Orders from Your Web Store

1. If the Main Menu is not already open, from the Options menu, choose Main Menu.

2. Click the Sales and Analysis tab.


3. Click Retrieve New Orders from Web. The Web Publishing Wizard screen appears.


4. Select Synchronize Web Store data with Client data.

5. Click Continue. The sales orders from your Web store are transferred to Commerce Court Pro.

Becoming a BuyWay merchant

Merchants choose which type of credit cards will be accepted for Internet transactions and then make sure that credit card account numbers meet the conditions imposed by the bank/acquirer.  Specifically, merchants must contact their banks/acquirers to make sure that their credit card accounts are allowed to accept Internet purchases.  If necessary, MPACT Immedia will provide names of financial institutions that support Internet transactions.

Merchant Web site prerequisites

As is the case for Club Web, merchants must have a web based electronic catalog of products with a shopping cart facility or a product offering on a Web page in order to use BuyWay.

Type of merchant account needed

Merchants must have Mail Order/Telephone Order (M.O.T.O.) merchant credit card accounts for their choices of credit card types such as VISA, MasterCard, and/or AMEX either:

· through a Canadian Bank(s) and American Express

· through a U.S. Bank/Acquirer

BuyWay requires merchants to maintain unique logical merchant numbers for the payment service; this specifically is in regards to merchants with existing credit card payment solutions. The destination of funds can be to the same bank account.

Banks and acquirers supported

BuyWay can process transactions with all banks in Canada and most U.S. banks and acquirers. 

FOR U.S. MERCHANTS:

U.S. merchants must have its accounts at Banks and Acquirers supported by our network. Merchants must provide the details on the merchant accounts as outlined in the “BuyWay Set-up Checklist” (following section) so that support may be verified. 

If the merchant’s current Bank or Acquirer is not supported, then the merchant may choose to:

· (preferably) switch to a BuyWay recommended acquirer, or 

· have BuyWay integrate the merchant’s acquirer at a potential cost premium.

Note   in both cases funds may be deposited directly into the merchant’s current bank account.

If the U.S. merchant does not currently have a M.O.T.O. account, support can be verified in advance and a source for such an account can be recommended if necessary.

What merchants should tell the banks/acquirers

If the merchant doesn’t already have a M.O.T.O. merchant account, it will be necessary to tell its bank/acquirer that it is planning to conduct secure Internet credit card transactions through a third party:  MPACT Immedia’s BuyWay service. If the bank/acquirer is unfamiliar with BuyWay, have the bank contact the BuyWay coordinator directly at MPACT Immedia  (514) 397-9747 x249 or via e-mail to buyway@mpact.net

Merchant credit card fees

Each bank/acquirer has its own specific fees and rates for merchant accounts.  Some may not charge a transaction fee, but may charge a slightly higher discount rate, and vice versa.  MPACT Immedia is not party to setting or negotiating individual bank/acquirer merchant account fees or rates.  MPACT Immedia provides an intermediary function, offering secure Internet credit card transactions and related value added services, and charges the merchant for these services as outlined in the BuyWay Service Agreement.  MPACT Immedia’s BuyWay fees are not included in Bank/Acquirer fees.  

How MPACT Immedia will invoice merchants

MPACT Immedia normally invoices the merchant directly for BuyWay services.  The merchant will receive a monthly invoice statement and will have access to information to reconcile the charges.

Alternatively, merchant may choose to have their company credit card charged automatically by BuyWay.

Recommended BuyWay Set-up Checklist

1. Read Product Description Document. 

2. Select credit cards to accept. (
3. Confirm current bank/acquirer support with BuyWay representative. 

4. Obtain merchant credit card account(s) for “card-not-present” (M.O.T.O) transactions as outlined in 'Becoming a BuyWay Merchant' in this document. ( 

5. Return filled in Information Request form. Using the attached form and the BuyWay Product Description Manual as a reference guide, specify to BuyWay representative the specific BuyWay features required. On-line entry will be available in the near future.(
6. Receive confirmation for any customization required. (
7. Receive custom BuyWay Service Agreement from BuyWay Representative. (
8. Complete and sign the BuyWay Service Agreement and Registration Form(s) and return the original copy and one-time set-up fee to BuyWay Representative  (
9. MPACT Immedia will forward a request to the financial networks for final authorization to process transactions.  The time it takes to receive this final authorization varies for each merchant and bank. 

10. Provide BuyWay Representative with the electronic location(s) where selected transaction outcome(s) and reports will be sent if not done in step 5. (
11. Complete integration of BuyWay with Web Site, as described in the Club Web Reference Manual. (
12. After MPACT Immedia sets up the merchant profile on BuyWay, receive Username and Password to access secure on-line Transaction History database and utilities

13. Receive green light to begin testing BuyWay. (
14. Conduct testing and make any necessary corrections.  (
15. Request BuyWay go live. 

16. Test the system with a few transactions of each card type using real credit cards.

17. Verify that the funds are correctly deposited into bank accounts (24 to 48 hours later).

18. Make site available to the World!(
Information Request Form
SALESPERSON: _________________________________DATE dd/mm/yy):__________________________
COMPANY NAME:________________________________________________________________________

ADDRESS:_________________________________________________  SUITE_______________________

CITY:______________________________ PROV./STATE ________________COUNTRY_______________

POSTAL/ZIPCODE:______________________________PHONE:_(______)__________________________

FAX:__(______)_______________________  URL:______________________________________________

COMPANY CONTACT:_____________________________________________________________________

TITLE:______________________________________E-MAIL:______________________________________ 

ANNUAL CREDIT CARD SALES $:________________________________  AVG. TICKET $:_____________

BUSINESS ACTIVITIES: ___________________________________________# OF LOCATIONS:_________

U.S. MERCHANT ACCOUNT INFORMATION:

CURRENT BANK NAME:___________________________________________________________________

BANK CONTACT NAME: _________________________________PHONE:_(_______)__________________

Bank#



Transit#                                   

ACCOUNT NUMBER:____________________________________     _______________________________




Card Type


Card Number



MERCHANT NUMBER:  _____________________   _____________________________________________

                        _____________________   _____________________________________________ 

                        _____________________   _____________________________________________

CURRENT PROCESSOR: __________________________________________________________________

CANADIAN MERCHANT ACCOUNT INFORMATION:

For each credit card you accept for payment, please give the following information for your ‘card-not-present’ account(s) (You must include a void cheque or deposit slip that outlines your bank accounts and transit numbers.  Include one for your MasterCard bank and one for your Visa bank): 

Merchant number,                 Bank account #,           Transit #,             Name and Bank location

(VISA)
___________________|__________________|______________|___________________________________

(Mastercard)
___________________|__________________|______________|___________________________________

(American Express)
___________________|__________________|______________|___________________________________

(Discover)
___________________|__________________|______________|___________________________________(                 )
___________________|__________________|______________|___________________________________

Name:______________________ Signature:_______________________  Date:______________________

Selected BuyWay Optional Features

Please check your selection from the following optional functions:




 




Perform Inventory check 

Inventory file size __________KB




Provide Electronic Software Download capability




Storage of Software for Downloads 

Number of Files__________

Average File size _________KB







Communication of transaction outcome record via:

Query to Merchant server







location: ______________________________

Query to fulfillment server 







location: ______________________________

On-screen to Buyer 








Outcome message to display in English: N/A

__________________________________________________________________________________________________________________________________________________________________________________

Outcome message to be displayed in other language (write in other language and specify the language): N/A

__________________________________________________________________________________________________________________________________________________________________________________

E-mail to Buyer 







E-mail to Merchant 







E-mail address: ____________________________________

E-mail to fulfillment 







E-mail address: ____________________________________

Fax to fulfillment 







Fax # _(______)______________________________

Fax to Merchant







Fax # _(______)______________________________

Communicate transaction reports:

Tab Delimited Flat file format 






Or CSV  (For easy import into Microsoft Excel™) format 







Frequency (if > 1/day):  _________

To E-mail:_________________________

Location of Merchant Logo image: ________________________________________________

Please complete and sign the above Merchant Checklist Form and return it to your BuyWay Representative or fax to the attention of BuyWay Registration (514) 398-0764 (fax).

Appendix

Electronic Commerce General Overview

Electronic Commerce (EC) is the fast growing marketplace of the 90's and will remain so well beyond the year 2000. Coupled with the Internet explosion, companies are rushing to implement new, World Wide Web based customer access sites.

The retail electronic commerce boom has also resulted in an overwhelmingly large demand for business-to-business EC. As companies continue to strive towards improving their customer-based operations, the need to streamline links to the supply chain becomes more apparent. As a result, larger enterprises are applying pressure on smaller partners to implement electronic commerce capabilities.

These developments have created an opportunity for the software application developer/provider. By integrating simple and functional EC capabilities into their products, forward-thinking software houses are improving their competitive positions and bolstering their revenue lines. 

EC merchandising requires an effort similar to that of merchandising in the physical world.

Web designers will need to interface with Merchants regarding the information required for their store (i.e.; product descriptions, pictures, pricing). 

Merchants will need to convey the various terms and conditions for their shopping site including and not limiting to shipping policies, options and costs, returns policies and the order fulfillment process. 

Responsibilities may include:

· Ensuring the correct information in their stores regarding product, pricing, terms and stock availability.

· Ensuring that all new product additions are available through the new product section of the stores.

· Ensuring that all special pricing or promotions and hot items are available in the specials section or hot items section of the stores.

· Ensuring database information so that the store can offer Search capabilities by category, brand, manufacturer, price and so on.

· Maintaining a FAQ regarding purchasing product from their store as well as Internet Security issues.

· Coordinating the marketing activities on and off the Internet

· Obtaining Mail Order / Telephone Order (MOTO) merchant accounts for accepting in order to accept credit card transactions on-line.

Internet merchandising provides a new market for existing and new product. A product that is not a best seller in the physical world may generate renewed interest in the virtual world. The Internet will open new markets for any product and provides an opportunity to gauge interest in new products.

Internet merchandising also provides an opportunity to reduce operating cost through automation. For example one of the potentially biggest benefits of shopping for software over the Internet is that it may be immediately downloaded on-line following a purchase. This is a benefit to the Software Vendor as well as it enables the vendor to automate data collection and analysis and minimize physical inventory cost such as the production and shipping of floppy or CD. Note that Electronic Software Distribution (ESD) has the added benefit of being able to keep inventory fresh.  

The Club Web initiative simplifies the entry into Electronic Commerce.

Compaq Overview

Founded in 1982, Compaq Computer Corporation, a Fortune 100 company, is a global information technology company. Compaq is the fifth largest computer company in the world and the largest global supplier of personal computers. With worldwide sales of $24.6 billion in 1997, Compaq develops and markets hardware, software, solutions and services, including industry-leading enterprise computing solutions, fault-tolerant business-critical solutions, networking and communication products, commercial desktop and portable products and consumer PCs. The company is an industry leader in environmentally friendly programs and business practices.

Compaq products are sold and supported in more than 100 countries through a network of authorized Compaq marketing partners. Customer support and information about Compaq and its products can be found at http://www.compaq.com or by calling 1-800-OK-COMPAQ in North America. Product information and North America reseller locations can be obtained by calling 1-800-345-1518.

Compaq North America is headquartered in Houston, Texas. Its products and services are sold and supported through a network of more than 25,000 commercial and consumer marketing partners across the United States and Canada.

Microsoft Overview

Since its inception in 1975, Microsoft’s mission has been to create software for the personal computer that empowers and enriches people in the workplace, at school and at home. Microsoft’s early vision of a computer on every desk and in every home is coupled today with a strong commitment to Internet- related technologies that expand the power and reach of the PC and its users. As the world’s leading software provider, Microsoft strives to produce innovative products that meet customers’ evolving needs. 

Microsoft® products include operating systems for personal computers, server applications for client/server environments, business and consumer productivity applications, and interactive media programs, and Internet platform and development tools. Microsoft also offers online services, sells personal computer books and input devices, and researches and develops advanced technology software products. Microsoft products, available in more than 30 languages and sold in more than 50 countries, are available for most PCs, including Intel microprocessor-based computers and Apple computers.

INEX Overview

Headquartered in Toronto, INEX Corporation (INEX) provides a suite of Internet commerce applications that allow organizations to easily conduct business over the World Wide Web. INEX’s solutions are successfully delivering the promise of electronic commerce to the masses today by providing organizations with the option of hosting a Web store locally or remotely through an Internet Service Provider (ISP). 

INEX offers Internet commerce applications that allow businesses to host Web stores locally or remotely. Because INEX’s solutions are affordable, easy-to-use and interoperable with an organization’s legacy systems, INEX has made it possible for organizations of all sizes to embrace the power and potential of Internet commerce. Today, INEX offers three versions of their flagship INEX Commerce Court product: INEX Commerce Court Enterprise, INEX Commerce Court Professional, and INEX Commerce Court Lite.

For more information please consult the INEX web site at http://www.inex.com

MPACT Immedia’s BuyWay: Overview

MPACT Immedia Corporation, a worldwide leader in Electronic Commerce, offers both EDI Commerce and Internet Commerce products and services through its offices in Montreal, Livonia (Michigan), and Toronto. By marketing with strategic partners, MPACT Immedia has developed a client list of many of the Fortune 1000 companies including such global players as Royal Bank of Canada, Bank of America, Mercedes-Benz and Bell Atlantic. Its advanced-technology EC solutions enable organizations to better compete in the global marketplace. 

